Single CAD Format File (SCFF) - Guidance Notes and Instructions
This document aims to provide instruction and guidance in preparing your Single CAD Format File (SCFF) for PDF plan and ePlan applications lodged in SPEAR.
This document should be read in conjunction with the SCFF List of Layers document available from the SPEAR website:  SPEAR > ePlan > SCFF and ePlan Creation service > SCFF layers, examples & templates
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	[bookmark: _Toc71542353][bookmark: _Toc84587953]What does the SCFF support?
	All cadastral applications in SPEAR are supported by the SCFF. This includes 3D plans at the site/ ground level, but not upper and lower boundaries and cross-sections.

	[bookmark: _Toc71542354][bookmark: _Toc84587954]CAD format
	CAD format must be DXF version 2010. See Appendix 1 for more information about how the CAD file can be exported to DXF in AutoCAD, MicroStation CONNECT and LISCAD.

	[bookmark: _Toc71542355][bookmark: _Toc84587955]Defined CAD layers
	
The 73 defined structured cadastral CAD layers of the SCFF aim to cover the main cadastral plan drawing requirements and connections to MGA.

SCFF layers must have only the expected feature types, being point, line, arc, text, unclosed polyline, and closed polyline (polygon). 

This defined structure ensures that the SCFF will be compatible for updating Vicmap. If the SCFF is not structured correctly, validation errors or loss of data through the ePlan Creation Service are expected.


	[bookmark: _Toc71542356][bookmark: _Toc84587956]Adding non-standard CAD layers
	
There is provision to include other layers in addition to the 73 defined cadastral layers in the SCFF, these are referred to as ‘non-standard’ layers. 

Non-standard layers can be added to supplement your own internal uses or to define cadastral information not defined in the SCFF (e.g. symbols, occupation other than offsets and building returns, and plan dimensions).

[image: Warning]NOTE:  Additional data supplied in non-standard layers will not be processed/validated by the ePlan Creation Service which produces the ePlan LandXML file. Please ensure all 	relevant plan/survey information is primarily defined in the standard layers. 


	[bookmark: _Toc71542357][bookmark: _Toc84587957]CAD preparation (computed plan)

	
The SCFF must be drawn in ‘model space’ (computed plan) at 1:1 scale without enlargements, exaggerations or on the plan template. 

[image: Lightbulb and gear]Tip: Enlargements and exaggerations must be added to the plan (PDF plan or ePlan visualisation), and not included in the model space.

	[bookmark: _Toc71542360][bookmark: _Toc84587958]Coordinate system / Connection to MGA

	While initial versions of the SCFF may be on a local coordinate system, the expectation is that the final version of the SCFF will be connect to MGA.  This is in line with the Victorian Cadastral Surveys Practice Directives. 

MGA connection must be reflected using the appropriate survey related CAD layers, i.e. control marks, reference marks, traverse points, traverse lines, and radiations. 

MGA connection will assist in streamlining the Vicmap Property and Digital Cadastre update process.

MGA connection should be undertaken, as follows:
· Capture one of the PMs or PCMs using its true MGA coordinates (from SMES)
· Capture other geometries based on ground distances and bearings oriented to MGA (if applicable)
[image: Warning]
NOTE:  Transformation to grid is not allowed.


	[bookmark: _Toc71542362][bookmark: _Toc84587959][bookmark: _Toc71542363]Parcels (fully closed polygons) and connections/ abutting roads
	
All parcels including lots, stage lots, common properties, roads, reserves, crown allotments, crown portions, easements, crown land services, and restrictions must be fully closed and drawn as individual polygons (i.e. not as individual line segments with no parcel misclosure).

Where a parcel contains a misclosure, surveying methodology must be applied, and the geometries of the parcel adjusted to close.

Depending on the methodology used, the dimensions in the PDF or visualised plan are to display the dimensions as maintaining title or adjusted accordingly.

[image: Warning]NOTE:  Connections and abutting roads must be drawn as unclosed polylines.


	[bookmark: _Toc71542364][bookmark: _Toc84587960]‘State’ of a parcel
	
All parcels (polygons) in the SCFF must be associated with a ‘state’ description. These are listed in the Layer Name column of the defined CAD layers. The state of parcels is defined as follows:

· Created:  A new parcel being created in a plan (e.g. (PS) plan of subdivision; (OP) original plan)
· Existing:  A parcel that exists on the cadastre
· Encroached:  An existing parcel encroached by a new boundary adoption from an abutting parcel
· Affected:  An existing parcel subject to amendment due to new boundary adoption from an abutting parcel 
· Cancelled:  An existing parcel subject to cancellation
· Removed:  An easement / restriction subject to removal.

Example: 
A plan of subdivision creating 5 new lots, 2 reserves and a road
· All 8 new parcels must be defined using the ’Created’ state.
· The land being subdivided (parent parcel(s) must be defined using the ‘Cancelled’ state.


	[bookmark: _Toc71542365][bookmark: _Toc84587961]Easements/ Crown Land Services
	
Easements and Crown Land Services parcels must be captured in SCFF as closed polygons. 

The label identifier for these parcels must be:
· Positioned within the subject polygon, and 
· Captured in the relevant text layer i.e. TEXT-EASEMENT-ID or TEXT-CROWN-LAND-SERVICE-ID

Other textual information associated with easements/crown land services descriptions must be drafted on the PDF plan or entered in the ePlan Creation Service user interface (i.e. ePlan Editor).

[image: Warning]NOTE:  If easements or crown land services overlap, there’s no need to create a separate geometry for the overlapping part in DXF. The ePlan Creation Service will automatically generate a polygon for the overlapping portion. However, you must place an identifier (e.g. E3) within the overlapping portion using the relevant text layer.


	[bookmark: _Toc71542366][bookmark: _Toc84587962]Textual Information
	
The SCFF must contain all textual information within the appropriate CAD layers, for all parcel ID’s and PM/PCM identifiers:

· PMs and PCMs must be labelled with their corresponding 9 figure number
· Text layers must follow the associated ‘Naming Convention for Text Layers’ as outlined in the SCFF Defined CAD Layers document available from the SPEAR website:  
SPEAR > ePlan > SCFF > SCFF layers, examples & templates
· Each closed parcel must have only one corresponding identifier label in its relevant text layer (positioned within the subject polygon)
· Where easements / crown land services overlap, the overlapping part must have only one corresponding identifier label in its relevant text layer.

[image: Warning]NOTE:  Parcels without a SPI have a naming convention of NOSPI–[#], e.g. NOSPI-1.
              Parcels not in Subdivision have a naming convention of NIS–[#], e.g. NIS-1.

[image: Warning]NOTE:  Other textual information associated with parcels such as easements, restriction descriptions and any plan/survey notations must be drafted on the PDF plan or defined in the ePlan Creation Service (ePlan Editor).


	[bookmark: _Toc71542367][bookmark: _Toc84587963]Offsets
	
Offsets must be drawn with line geometry instead of being defined by an offset distance. The offset line geometries must be defined in LINE-OFFSET layer.

Typically, offsets will be used in the SCFF to define the width of easements, or to relate the location of an easement/restriction to a parcel boundary.

[image: Lightbulb and gear]Tip: If there are sufficient geometries to establish the width of an easement or the width can be described on the easement table of the plan, the use of offsets is not required.


	[bookmark: _Toc71542368][bookmark: _Toc84587964]Splay corners
	
Splay corners must be captured using two lines/arcs and defined in the LINE-CONNECTION layer.

The example below shows a splay corner captured using two connection lines with a dashed line style, with both lines extending from the corner to the splay boundary.

[image: ]


	[bookmark: _Toc71542369][bookmark: _Toc84587965]Building boundaries, natural boundaries, and unsurveyed boundaries
	
Building boundaries, natural boundaries, and unsurveyed boundaries must be captured in their specific layers: LINE-BUILDING-BOUNDARY-EXTERIOR, LINE-BUILDING-BOUNDARY-INTERIOR, LINE-BUILDING-BOUNDARY-MEDIAN, LINE-BUILDING-BOUNDARY-OTHER, LINE-NATURAL-BOUNDARY, LINE-UNSURVEYED-BOUNDARY.

These boundaries must also be included in their respective parcels. All the nodes for these boundary lines must exist in the structure of their corresponding parcels.










Example: 
[image: ]

· In this example, the cancelled lot is shown as Lot 1\PS123456 and is defined in layer LOT-CANCELLED. It is being re-subdivided into two created lots and one reserve. The new parcels have been created in layers: LOT-CREATED and RESERVE-CREATED.

· Lots 1 and 2 share a median building boundary 
· The median building boundary line between points 13 and 14 is defined in layer LINE-BUILDING-BOUNDARY-MEDIAN

· The polygon for Lot 1 is defined by the points 1, 2, 14, 13, 12, 11, and 1.
· The polygon for Lot 2 is defined by the points 2, 3, 4, 12, 13, 14, and 2.
· As shown, points 13 and 14 are common between the Lot 1 and 2 polygons.

· The polygon for Reserve 1 (RES1) is defined by the points 11, 12, 4, 5, 6, 7, 8, 9, 10, and 11.
· RES1 consists of an unsurveyed boundary and a natural boundary. 
· The unsurveyed boundary line between points 4 and 5 is defined in layer LINE-UNSURVEYED-BOUNDARY. 
· [image: ]The natural boundary lines between points 5, 6, 7, 8, 9, and 10 are defined in layer LINE-NATURAL-BOUNDARY. 

TIP:  To capture natural boundaries, avoid using spline, and use line instead.
[image: Lightbulb and gear]
TIP:  The natural boundary points can be defined by digitally tracing straight lines over the natural boundary, thus forming line from the start to end (shown as points 5 to 10).


	[bookmark: _Toc71542370][bookmark: _Toc84587966]PM/PCM
	
PMs and PCMs must be labelled with their corresponding 9 figure number. The 9 figure numbers are available from the PM Sketch plan which can be obtained from SMES.

Example:
The insertion point of the PM/PCM label in the SCFF should be as follows:
· The lower left corner of the text label (9 figure number) must be positioned exactly on the PM/ PCM point coordinates
· The actual PM/PCM Mark Name (e.g. PM 871) is not required, as this will be automatically retrieved from SMES using the 9 figure number (in the ePlan Creation Service). 
[image: ]


Example:  
The 9 figure number for KEELBUNDORA PM 871 is compiled as follows: 
Typically a zero, unless the mark is an eccentric to the primary mark
PM Number
Parish code


	[bookmark: _Toc84587967]Snapping points
	Points defining parcel boundaries should be appropriately snapped to avoid validation issues. 
Below is an example of correct snapping for points of parcels 6, 7, and E1, which are snapped and created at the correct location.
   [image: ]


In the below example, points for E1 are not properly snapped.[image: ]

	[bookmark: _Toc84587968]Road Connections
	The road alignment in a plan should be defined by connecting it through the parcel boundary points that intersect or are coincident with the road.

This is required so that road connections can be determined and displayed on the plan visualisation.  At a minimum, the outer corners of the subject land, which abut the road should be used to define the road alignment, together with the road polyline (or polygon).  

Below is an example of correct road connection which shares 4 points with the subject parcel:

[image: ]
The below example shows an incorrect road connection which does not share any point with the subject parcel:

[image: ]
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[bookmark: _Toc71542372][bookmark: _Toc84587969]Appendix 1: Exporting to DXF in AutoCAD, MicroStation CONNECT and LISCAD
The information below has been provided by the ePlan team and Surveyor-General Victoria teams, based on their experience using AutoCAD, LISCAD and MicroStation CONNECT. If these instructions do not correlate with your own CAD package/customisation, please contact your vendor for more specific information.
	Exporting to DXF in AutoCAD
	
Option 1
· 'Save As', choose the File Type (AutoCAD 2010/LT2010 DXF (*.dxf))
· This will save the whole drawing which will remain open and the extension .dxf will be shown in the tab
· Any changes done from this point will be to the DXF only and will need to be saved as a dwg if required when closing the file

Option 2
· ‘Save As’, click on Tools on the top right corner and choose ‘Options’
· Click ‘DXF Options’, then ‘Select Objects’ and ‘OK’
· Choose the dxf version in the Files of type (AutoCAD 2010/LT2010 DXF (*.dxf)) and ‘Save’
· Select everything that you require and ‘Enter’
· The dxf will be saved in the folder and the opened drawing will remain a dwg


	Exporting to DXF in MicroStation CONNECT





	
Option 1
· Export entire design file
· Select File>Export>DWG
· In the ‘Save As’ type field select - Autodesk® DXF Files (*.dxf)
· At the bottom of the export dialog select ‘Options’.
· Expand the directory ‘Basic’ and select the DWG Version - 2010/2011/2012.
· Set any other required options and then select ‘OK’.
· Choose the desired file location and enter the name of the export file in the File name field.
· Select enter to save the export.

Option 2
· Export selected/fenced elements
· Place a fence using the fence tool, setting Fence Type to Block and Fence Mode to Inside.
· Select File>Export>DWG
· In the ‘Save As’ type field select - Autodesk® DXF Files (*.dxf)
· At the bottom of the export dialog select ‘Options’.
· On the General tab, expand the directory ‘Basic’ and select the DWG Version - 2010/2011/2012.
· On the Filter tab, set Geometry to Fence and Fence Mode to Inside. 
· Set any other required options and then select ‘OK’.
· Choose the desired file location and enter the name of the export file in the File name field.
· Select ‘enter’ to save the export.
[image: Warning]
NOTE:   
· Ensure cells are stored as type ‘point’ in cell/dgnlib library files.
· Ensure cells are placed in the design file as ‘shared cells’
· Delete any existing ‘shared cell definitions’ from the design file before exporting to dxf.
· The command/key in to be used is ‘delete scdefs all’.





	Exporting to DXF in LISCAD
	1. Ensure that ‘Ground’ is chosen for distance in the Units Configuration menu (from the Configure tab)
[image: ]

2. Set up groups for the relevant elements. These will convert to layers in the .dxf output file. Alternatively, you can use the provided template which contains the standard groups.

3. Note the different element types required in the output .dxf file. To produce those elements in LISCAD they must be created as follows:
· Lines as line segments, such as LINE-TRAVERSE or LINE-CONNECTION
· Polylines as line strings, such as ROAD-EXISTING or LOT-EXISTING
· Polygons as polygons, ensuring that the line attributes are set to DEAFULT code and DEFAULT group. This prevents the polygons to be duplicated in the .dxf output.
· The point code should be set to DEFAULT and the group to DEFAULT, except for the point-based layers (POINT-CONTROL-PM, POINT-TRAVERSE, etc). Set code to DEFAULT and group to the relevant layer for those.

4. The drawing should be entered from a point with known co-ordinates such as a Permanent Mark.

5. Set point attributes to code DEFAULT and group POINT-CONTROL-PM and enter the starting point by co-ordinates.

6. Set point attributes to code DEFAULT and group POINT-TRAVERSE.

7. Set line attributes to code DEFAULT and group LINE-TRAVERSE.

8. Enter the traverse.

9. Set line attributes to code DEFAULT and group LINE-RADIATION.

10. Enter at least one adopt radiation.

11. Set line attributes to code DEFAULT and group DEFAULT.

12. Draw all closed parcels as line strings, including easements, restrictions, etc.

13. Set polygon attributes to code 901 and group LOT-CREATED

14. Draw the closed parcel representing the cancelled lot as a polygon.

15. Set polygon attributes to code 902 and group LOT-CANCELLED.

16. Draw the closed parcels representing the created lots as polygons.

17. Repeat the last two steps with any other closed parcels (easements, etc). Remember to use a different polygon code for each different layer.
In the CAD Output / Settings menu, the ‘Fill’ settings for polygons must be set for each code to match the desired output layer. Note: ‘Fill’ does not have to be ticked. 
In the example provided the following layers have been set:
901 LOT-CREATED
902 LOT-CANCELLED
903 COMMON-PROPERTY-CREATED
904 EASEMENT
905 RESTRICTION-CREATED

18. Text needs to be wholly contained within the corresponding parcel. Depending on the size of the parcel, it may be advisable to set units to ‘ground’.

19. In the Task menu select ‘CAD Output’. 

20. In the Settings menu / CAD System select ‘AutoCAD’.

21. Click ‘Output!’ and ensure scale is set to 1:1 and file type as ‘AutoCAD 2010/2011/2012 (*.dxf)’

22. Click ‘Options’ and ensure the following boxes are ticked: 
· Layer Name as Group
· AutoCAD Default Points
· Polygons as 2D Polylines
[image: ]

23. Click ‘OK’, this will generate a .dxf file ready for SCFF validation.
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